
Kapitola 2 

Globální osvětlení 
(GI), renderování 

a kamerové efekty 
V této kapitole se seznámíte s některými pokročilými funkcemi v oblasti globálního osvětlení, 
renderování a kamer. Jako v první kapitole, i zde půjde zejména o krátké tipy či řešení, kte-
rá budete moci ihned aplikovat na vaše projekty. V první části se budeme zabývat globálním 
osvětlením, v druhé části se podíváme na některá elementární řešení z oblasti osvětlení, kamer 
a renderování. Globální osvětlení v oblasti 3D grafi ky je dnes téměř nezbytností a vychází z ang-
lického pojmu Global Illumination (někdy také Indirect Illumination) a my jej budeme nadále 
označovat zkratkou GI. V 3ds Max lze napodobit GI buď pomocí pokročilého osvětlení Light 
Tracer a Radiosity v renderovacím režimu scanline nebo pomocí výkonného rendereru mental 
ray, který je ve verzi 3.6 součástí základního vybavení 3ds Max 2009. Známé renderovací modu-
ly výrobců třetí strany pro globální osvětlení jsou:

V-Ray (www.chaosgroup.com)
Brazil r/s (www.splutterfi sh.com)
fi nal Render (www.cebas.com)

Jejich ceny se pohybují přibližně kolem 1 000 dolarů. Další známější renderer je Maxwell (více 
viz www.maxwellrender.com). U něho stojí za povšimnutí, že používá spektrální renderovací 
technologie (světlo je považováno za elektromagnetickou vlnu, na rozdíl od standardního po-
užití barev RGB). Jde o novou generaci technologie v renderování. V této knize se seznámíme 
s možnostmi Light Tracer, Radiosity a mental ray.
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54 Kapitola 2 – Globální osvětlení (GI), renderování a kamerové efekty

Správné nasvícení scény pomocí globálního 
osvětlení 
Vzhledem k více možnostem aplikování GI v 3ds Max rozdělíme téma do jednotlivých bodů 
podle využitého rendereru. K tomu bude třeba načíst scénu, na níž si techniky vysvětlíme. 

Osvětlení interiéru pomocí Light Tracer 
Pokud chcete napodobit globální osvětlení v 3ds Max a používáte renderer scanline (to, že jej 
máte aktivní, poznáte v hlavním menu Rendering → Render Setup → záhlaví ukazuje Render 
Setup: Default Scanline Renderer), pak využívejte pokročilá osvětlení Radiosity nebo Light Tra-
cer, která aktivujete přes hlavní menu Rendering. V tomto bodu se budeme věnovat nastavení 
Light Tracer, které je ve srovnání s radiozitou méně přesné, avšak jednodušší na nastavení. 
Pro objasnění hodnot parametrů Light Tracer si načtěte scénu 01interier-lt.max ze složky kapi-
tola1-2\max na přiloženém DVD-ROM. Scéna je připravená pro použití pokročilého osvětlení 
LT a využívá světelný systém Daylight. 

Kde a jak nastavit hlavní světelnou intenzitu 
Parametry Light Tracer najdete v menu Rendering → Light Tracer. Na následujícím obrázku 
vidíte nastavení LT ve scéně 01interier-lt.max.

Obrázek 2.1 Hodnoty parametrů pokročilého osvětlení Light Tracer

Hlavní úroveň světelné intenzity ve scéně nastavujeme pomocí parametru Global Multiplier. 
Další obrázek porovnává dvě ukázky renderované pomocí LT s různou hodnotou parametru 
Global Multiplier. 

01interier-
lt.max
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Obrázek 2.2 Výsledek nastavení Light Tracer s globálním multiplikátorem=1.0 (příklad 1) a 2.0 

(příklad 2)

Je zřejmé, že první obrázek je tmavší díky menšímu multiplikátoru (s hodnotou 1.0), který ovlá-
dá celkovou úroveň světla ve scéně. 

Dosažení výraznějšího prosvětlení 3D prostoru 
Abyste zvýšili celkovou světelnost v místnosti, zvyšte parametr Bounces (číslo určující souhrnný 
počet, kolikrát se světelný paprsek odrazí od objektů, na které dopadá) na hodnotu 2. 
Výsledkem je o poznání světlejší místnost s viditelnými fl eky (způsobeno nízkým počtem paprs-
ků – Rays a nízkou hodnotou fi ltru – Filter Size). 

Obrázek 2.3 Výsledek nastavení Light Tracer s hodnotou globálního multiplikátoru=2.0 

a zvětšením parametru Bounces na hodnotu 2.0

Dosažení výraznějšího prosvětlení 3D prostoru
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56 Kapitola 2 – Globální osvětlení (GI), renderování a kamerové efekty

Snížení doby renderování 
Zvýšení parametru Bounces z předchozího kroku dramaticky zvýší renderovací dobu (přibliž-
ně 2×), efektivnější tedy bude zvýšit hodnotu multiplikátoru IES Sky v modifi kačním panelu 
u systému Daylight v roletce IES Sky Parameters (například na hodnotu 3.0 ze současných 1.0, 
jak ukazuje obrázek 2.4) s ponecháním hodnoty parametru Bounces=1.0. Výsledek bude téměř 
stejně světlý jako obrázek 2.3, avšak s polovičním časem renderu k dobru. Někdy se ale neu-
bráníme zvýšení hodnoty Bounces, jestliže je místnost příliš komplexní s mnoha rohy, kam se 
světlo nedostane, pokud nastavíme Bounces pouze na hodnotu 1. 

Obrázek 2.4 Zvýšení multiplikátoru IES Sky na hodnotu 3.0 (s ponecháním parametru Bounces 

u LT na hodnotě 1.0)

Jedinou nevýhodou je ztráta odražené (pískové) barvy podlahy na okolní zdi (efekt přelévání 
barvy mezi objekty navzájem má na starost parametr Color Bleed), kterou „přebije“ barva nebes 
defi novaná v roletce IES Sky Parameters, protože jsme zvýšili multiplikátor na hodnotu 3.0. 
Color Bleed má viditelný efekt, pokud nastavíte hodnotu Bounces na 2 a více. 

Dosažení přirozeného osvětlení interiéru budovy 
Dále si ukážeme varianty nastavení Light Tracer, podle nichž si odvodíme optimální řešení pro 
osvětlení scény podobného rázu jako v souboru 01interier-lt.max. Pro oživení je dále na obráz-
cích variant (2.5 až 2.7) pohled kamery nastaven opačným směrem ke dveřím (pohled Came-
ra03). Nejdříve si však musíme objasnit všechny parametry určující konečný vzhled osvětlení 
interiéru budovy: 

Multiplikátor IES Sky u systému Daylight určuje intenzitu světla pronikající z nebeské 
klenby.
Zvětšená hodnota parametru Object multiplier u Light Tracer způsobí vyšší míru osvět-
lení, protože každý objekt více přispívá svým odraženým světlem ke globálnímu osvět-
lení. 
U některých nastavení na dalších obrázcích (s rozlišením 320×240) jsme zvýšili i hod-
notu Bounces (tolerovali jsme dlouhou renderovací dobu).
Také se zvýšila hodnota parametru Filter Size (v rozmezí 6–7), čímž se eliminovaly zna-
telné fl eky na površích modelů.
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K renderování byl použit systém Windows XP SP3, QuadCore CPU 2.4 GHz, 4 GB RAM pamě-
ti. Odtud vycházejí doby renderování v jednotlivých případech.
Jak si lze na obrázcích všimnout, změnily se i parametry v sekci Adaptive Undersampling (oproti 
standardnímu nastavení na obrázku 2.1). Na obrázcích 2.5 a 2.6 je zmenšená hodnota paramet-
ru Initial Sample Spacing na 4×4 pixelů (zvýší se tak počet vzorků (Samples) scény z původního 
počtu vzorků o velikosti 16×16 pixelů), čímž se sice zvýší doba renderování, ale zvýší se kvalita 
obrazu, protože připadne více paprsků na jeden vzorek (počet paprsků na vzorek má na starost 
parametr Rays/Sample). Pouze u obrázku 2.7 jsme snížili hodnotu až na 2×2 pixelů s hodnotou 
Subdivision Contrast=1, abychom ještě více potlačili nežádoucí skvrny. 
Parametrem Subdivision Contrast jsme snížili toleranci (prahovou hodnotu) pro další dělení na 
menší vzorky (2×2 nebo 1×1). Další dělení tedy nastane už v době, kdy je detekován kontrast 
RGB barev mezi vzorky vyšší, než je hodnota uvedená v poli Subdivision Contrast. 
Doporučuji detailně zhlédnout rozdíly přímo na obrázcích na přiloženém DVD-ROM v adre-
sáři kapitola1-2\obr. Multiplikátor IES Sky u systému Daylight zůstává ve všech třech případech 
na hodnotě 3.0: 

Obrázek 2.5 Global a Object 

Multiplier=3.0, Rays/Sample=1500, 

Bounces=1, Filter Size=7.0. Místnost 

je poměrně tmavá díky nízké hodnotě 

parametru Bounces. I vysoký počet paprsků 

nedokáže kompenzovat nízkou hodnotu 

Bounces=1. Doba renderu 6 minut.

V případech 2.5 a 2.6 byla použita logaritmická expozice s aktivní volbou Exterior Daylight,  
Brightness=65 a Contrast=55. 
Přestože jsou na obrázku 2.7 nepatrné fl eky, řešením pro jejich odstranění by bylo zvýšit hod-
notu Rays/Sample podle časových možností, jinak bude doba renderování dramaticky narůs-
tat. Logaritmická expozice zde byla nastavena s aktivní volbou Exterior Daylight a parametry 
Brightness=70 a Contrast=57. 
Ze složky kapitola1-2\max na přiloženém DVD-ROM si můžete načíst fi nální nastavení LT ze 
souboru 01interier-lt-fi nal.max, které odpovídá obrázku 2.7.

01interier-
lt-final.

max

Dosažení přirozeného osvětlení interiéru budovy

K1623.indd   57K1623.indd   57 31.10.2008   13:42:3331.10.2008   13:42:33



58 Kapitola 2 – Globální osvětlení (GI), renderování a kamerové efekty

Obrázek 2.6 Global Multiplie =2.0 

a Object Multiplier=3.0, Rays/Sample 

=500, Bounces=2, Filter Size=7.0. Místnost 

je nyní světlejší, jelikož jsme zvýšili hodnotu 

Bounces, avšak stále s mnoha fl eky (nízká 

hodnota Rays/Sample). Doba renderu

4 minuty 45 sekund.

Obrázek 2.7 Global Multiplier=2 

a Object Multiplie =3.0, Rays/Sample

=1500, Bounces=2, Filter Size=6.5, 

Subdivision Contrast=1, Initial Sample 

Spacing=2x2. Postačující řešení s dobou 

renderování 15 minut

Osvětlení interiéru pomocí radiozity 
V tomto bodě se seznámíte s optimálním nastavením osvětlení interiéru pomocí radiozity. Jde 
o jediný systém v režimu scanline, který přesně spočítá nepřímé osvětlení ve scéně. Light Tracer 
řešení nepočítá zcela přesně, radiozita ano. 
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Pokud vaše scéna neobsahuje mnoho detailních síťových objektů, pak můžete využít radiozitu 
(v opačném případě by mnoho objektů mohlo zahltit paměť RAM). Radiozita je oproti Light 
Tracer mnohem náročnější na paměť RAM, je však fyzikálně přesnější a v mnohých případech 
může být také rychlejší se srovnatelnými výsledky. 
Efektivní vlastností tohoto řešení je Radiosity Adaptive Subdivision, což je funkce optimalizující 
náročnost na paměť RAM ve scéně s mnoha objekty (viz tip ke konci této podkapitoly). 
Abyste docílili vynikajícího osvětlení, které může napodobit globální osvětlení, bude třeba 
objasnit si související parametry radiozity. Proto použijeme soubor 03-interier-radiosity.max, 
v němž je řešení již hotové, a my si popíšeme související parametry.
Ze složky kapitola1-2\max na přiloženém DVD-ROM načtěte soubor 03-interier-radiosity.max. 
Otevře se stejný pohled Camera03 jako v minulém bodě (abychom mohli daná řešení srovnávat). 
Pokud se rozhodnete pro radiozitu, klepněte na menu Rendering → Radiosity. Objeví se dialog 
jako vpravo na obrázku 2.8. Naše scéna je již s vyřešenou radiozitou, jejíž výsledek je uložen 
ve vrcholech síťových modelů (proto má scéna více MB než u Light Tracer). Pokud byste chtěli 
řešení nechat spočítat znovu od začátku, bylo by třeba resetovat řešení tlačítkem Reset All a poté 
klepnout na tlačítko Start, které se po resetování řešení zobrazí na místě aktuálního tlačítka 
Continue.
Řešení je velmi kvalitní a s dobou renderu v porovnání s LT nesrovnatelně nižší. K výsledné 
kvalitě obrázku je třeba nastavit několik parametrů:

Určení počáteční kvality celkového osvětlení 
Řešení radiozity je ukončeno na 85 % úrovně kvality (nastavujete jej parametrem Initial Quali-
ty), což znamená, že distribuce světelné energie je vypočtena s 85% přesností. Nastavení vidíte 
na obrázku 2.8. 

Vylepšení celkové kvality obrázku 
Jestliže budete chtít vylepšit kvalitu obrazu a pokud byste ve scéně zjistili znatelné rozdíly 
(kontrasty) barev sousedních čelních ploch modelů, zvyšte hodnotu parametru Refi ne Iterati-
ons (All Objects) o hodnotu 1. Jde v podstatě o zlepšení celkové kvality renderu s minimalizací 
výrazných přechodů (často černá versus světlá místa) mezi barvami čelních plošek objektů. 
To však nebyl případ scény 03-interier-radiosity.max, hodnota parametru je proto ponechána 
na hodnotě 0. 

 03-
interier-

radiosity.
max

Vylepšení celkové kvality obrázku
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Obrázek 2.8 Nastavení parametrů u radiozity (vpravo) 

a současně nastavení expozice (vlevo) s obrazovým 

výsledkem těchto nastavení

Zbavení se skvrn a fl eků na vyrenderovaném obrázku 
Jakmile na vyrenderovaném obrázku zjistíte výskyt skvrn (viz například obrázek 2.8 nahoře na 
stropě), zvyšte hodnotu Filter Radius (pixels) na větší hodnotu (o jednotky) v roletce Rendering 
Parameters. (Příliš vysoké hodnoty však mají za následek ztrátu světelných detailů.) Tímto do-
jde ke zprůměrování či slití sousedních skvrn a nežádoucí skvrnitost (anglicky noise čili šum, 
zrnění) se tak na plochách modelů sníží. Odstranit fl eky můžete také zvýšením hodnoty Rays 
per Sample, čímž sice dojde k prodloužení doby renderování (na rozdíl od parametru Filter Ra-
dius), avšak zvýší se skutečný počet paprsků ve scéně – tedy skutečných detailů.

Získání jemnějšího a detailnějšího osvětlení 
Pokud na výsledném obrázku nevidíte moc detailů, scéna není dostatečně osvětlená nebo je 
příliš plochá, pak je to možná tím, že radiozita nemá dostatek vrcholů, kam by uložila své řešení. 
Bude třeba zjemnit síťové modely ve scéně, což lze učinit zapnutím pole Enabled v části Global 
Subdivision Settings (viz obrázek 2.8) na roletce Radiosity Meshing Parameters. Pak jen stačí 
nastavit parametr Maximum Mesh Size na dostatečně nízkou hodnotu, čímž se zvýší množství 
vrcholů, kam se radiozita bude moci uložit. Pro automatické a efektivní řešení rozdělení a roz-
ložení detailů síťoviny ve scéně (podle výskytu světla a stínů) využijete pole Adaptive Subdivisi-
on. Na obrázku 2.8 je dělení síťoviny zapnuto na 1 metr, což umožní radiozitě ukládat řešení na 
více čelních ploch scény (po 1 metru) a výsledkem bude detailnější řešení.

Nastavení hustoty sítě modelů

Přímé a nepřímé osvětlení
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Dosažení současně přímého a nepřímého osvětlení 
Pokud dopadají sluneční paprsky přímo na nějaký objekt, hovoříme o přímém osvětlení (Direct 
Illumination). Pokud však světlo proniká odrážením od různých objektů navzájem i tam, kam 
sluneční paprsky nedopadají přímo, hovoříme o nepřímém osvětlení (Indirect Illumination). 
Radiozita dokáže tento efekt věrně napodobit prostřednictvím roletového menu Rendering 
Parameters, které představuje jádro kvality osvětlení. Dialog vpravo dole na obrázku 2.8 nabízí 
celkem tři možnosti: 
Můžete využít přímé osvětlení vypočtené z radiozity (světlo dopadá na objekty přímo skrze 
střešní okno – viz vpravo dole pod otevřeným oknem). K tomu slouží volba Re-Use Direct Illu-
mination from Radiosity Solution. „Nepěkný“ výsledek této volby je patrný z obrázku 2.9.

Obrázek 2.9 Volba Re-Use Direct Illumination from Radiosity Solution použije přímé osvětlení 

z řešení radiozity, nikoli přímé osvětlení počítané při scanline renderování. Chybí zde ostré 

světelné přechody typické pro prudké přímé světlo. Výsledek je příliš „plochý“.

Nebo využijete volbu Render Direct Illumination bez možnosti Regather Indirect Illumination, 
což bude mít za následek přímé osvětlení získané ze scanline renderování, avšak bez nepřímého 
osvětlení. 
Nejlepší možnost (renderování zde také trvá nejdéle) je tedy Render Direct Illumination + Rega-
ther Indirect Illumination. Na obrázku 2.10 vidíte výsledek této volby společně s nastavením 
jedné z variant expozice. 
Parametr Rays per sample určuje počet paprsků připadajících na vzorek. Čím vyšší je tato hod-
nota, tím méně skvrn bude na objektech. V našem případě jsme nastavili hodnotu na 300 – 
výsledek je patrný z obrázku 2.10. 

Pokud byste chtěli dosáhnout lepšího výsledku pomocí volby Re-Use Direct Illumination from 
Radiosity Solution, nezbude vám nic jiného než zvýšit parametr Initial Quality a/nebo snížit 
hodnotu Meshing Size. Tím by se zvýšila doba nutná pro výpočet radiozity, ale její řešení by bylo 
obsaženo v mnoha menších částech síťoviny, a tudíž by zde díky jemnější síťovině byl větší pro-
stor pro detail a vyniklo by i přímé osvětlení vypočtené z radiozity. Obrázek 2.11 ukazuje takový 
postup při Maximum Mesh Size=0,1m (místo původního 1 metru) s kvalitou ponechanou na 
85 %. Scéna tak má více MB, řešení radiozity trvalo déle, ale následně s rychlejším scanline 
renderováním. 

Dosažení současně přímého a nepřímého osvětlení
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Výsledek je sice lepší než na obrázku 2.9, ale zdaleka není 
tak přesvědčivý jako na obrázku 2.10, protože obsahuje stále 
mnoho skvrn. 
Závěr: Pokud zrovna jen netestujete a chcete využít přesné 
osvětlení z radiozity, používejte volbu Render Direct Illumination + Regather Indirect Illumination.

Funkce Use Adaptive Subdivision umožňuje, aby se síťovina dále dělila na dílčí části pouze 
v těch místech scény, kde na plochu dopadá větší množství světla, a proto je zde třeba zvýšit 
počet vrcholů (zjemnit či dále rozdělit síťovinu), do nichž se data o dopadajícím světle uloží. 
Ostatní místa scény, kam světlo příliš nedopadá, není třeba dále dělit na menší plochy. Proto lze 
nastavit hodnotu maximální velikosti plošky (Maximum Mesh Size) po adaptivním dělení, mini-
mální velikost (Minimum Mesh Size) nebo prahovou hodnotu dalšího dělení ploch (Contrast 
Threshold) – tj. pokud se budou hodnoty světla uložené ve vrcholech dané čelní plochy lišit 
o více, než je uvedeno v poli Contrast Threshold, bude se ploška dále dělit. Výhodou je tedy 
úspora času i paměti, pokud pracujete s komplexnější scénou, v níž chcete použít radiozitu. 

Ze souboru 01interier-radiosity-fi nal.max ve složce kapitola1-2\max na přiloženém DVD-ROM 
si můžete načíst nastavení radiozity, jejíž výsledek vidíte na obrázku 2.10. Podívejte se také na 
obrázky Adaptive_radiosity_ON.bmp a Adaptive_radiosity_OFF.bmp na přiloženém DVD-
ROM a porovnejte výsledky řešení radiozity s adaptivním a globálním dělením. 

Obrázek 2.10 Možnost Render Direct Illumination 

společně s Regather Indirect Illumination poskytuje 

nejlepší řešení

Obrázek 2.11 Ukázka 

renderování pomocí volby 

Re-Use Direct Illumination 

from Radiosity Solution 

se zmenšením hodnoty 

Maximum Mesh Size na 

10 cm a nabídka Radiosity 

Meshing Parameters
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Při každé změně parametru v dialogu u radiozity zkontrolujte, zda se v první roletce Radiosity 
Processing Parameters neobjeví varování: „Solution is invalid at current time frame.“ Pokud ano, je 
třeba resetovat řešení (Reset All) a znovu jej nechat přepočítat tlačítkem Start, protože řešení se stalo 
vzhledem ke změně některého parametru nebo manipulace s objektem ve scéně neplatné. 

Zesvětlení obrázku po provedeném renderování 
Jestliže preferujete spíše světlejší obrazové výstupy (s nenasycenými barvami), můžete tento 
efekt přímo korigovat pomocí funkce Gamma. A to buď při ukládání obrázku klepnutím na 
ikonu diskety na vyrenderovaném snímku v dialogu Save Image (obr. 2.12, příklad 1) a přepsá-
ním hodnoty Override nebo trvalým nastavením parametru Output Gamma v hlavním menu 
Customize → Preferences → záložka Gamma and LUT. Obě varianty vidíte na obrázku 2.12. 
Na obrázku 2.13 vidíte porovnání obrázků uložených s hodnotou Gamma=1.0 (vlevo) a 1.35 (vpravo).

Obrázek 2.13 Porovnání dvou výstupů s hodnotou Gamma=1.0 (vlevo) a 1.35 (vpravo)

Obrázek 2.12 Možnost zesvětlení výstupu pomocí funkce Gamma přímo při ukládání obrázku 

v řádku Override (příklad 1) nebo globálně v dialogu Preference Settings na záložce Gamma 

(příklad 2)

Zvýšení hodnoty GAMMA

Zesvětlení obrázku po provedeném renderování

1
2
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Osvětlení interiéru pomocí mental ray 
Od verze 3ds Max 6 je součástí základního vybavení renderer mental ray od fi rmy mental images GmbH. 
S jeho pomocí můžete dosáhnout globálního osvětlení, přirozených materiálů nebo kaustických ploch 
vzniklých lomem nebo odrazem světla při průchodu objektem s průhledným materiálem. V součas-
nosti profesionálové v oblasti 3D grafi ky využívají spíše možností externích renderovacích modulů (V-
Ray, Maxwell, Brazil R/S, fi nalRender). Šíře nastavení je v těchto případech mnohem větší, nežli je tomu 
u scanline renderování. Proto je uživatelům 3ds Max k dispozici renderovací modul mental ray, který 
tyto vlastnosti nabízí a je srovnatelný s řešeními externích dodavatelů. Abychom si objasnili princip 
a nastavení GI pomocí mental ray, bude třeba načíst si vzorovou scénu 04-interier-mr.max. 
Ze složky kapitola1-2\max na přiloženém DVD-ROM si načtěte soubor 04-interier-mr.max. Otevře se 
vám stejná scéna, avšak s nastaveným rendererem mental ray. To, že jej máte aktivní, poznáte v hlav-
ním menu Rendering → Render Setup → záhlaví ukazuje Render Setup: mental ray Renderer. 

Globální osvětlení s mental ray 
Pokud chcete využít globální osvětlení v tomto režimu, aktivujte hlavní menu Rendering → 
Render Setup → záložka Indirect Illumination. Zde najdete parametry pro úpravu globálního 
osvětlení. Základem pro použití GI s mental ray jsou aktivní pole Enable Final Gather a Global 
Illumination, jak ukazuje obrázek 2.15. 

Final Gather (FG) je dodatečná technika rendereru mental ray, kdy je zpřesněn výpočet nepří-
mého (abstraktněji globálního) osvětlení. Zapnutím této volby zvýšíte počet paprsků ve scéně, 
čímž lze odstranit nežádoucí „tmavá či skvrnitá“ místa. Tato technika je obdobou regatheringu 
u radiozitního osvětlení v režimu scanline. Často si vystačíte pouze s parametrem Final Gather 
(bez Global Illumination).

Poměrně přesvědčivý výsledek renderování takto nastavené scény vidíte na obrázku 2.14. 
K tomuto stačily pouze čtyři úpravy:

1. Přepnout v modifi kačním panelu u denního osvětlení Daylight na mr Sun a mr Sky (mís-
to původních IES Sun a IES Sky).

2. Zapnout Enable Final Gather. 
3. Nastavit Initial FG Point Density a Rays per FG Point na 0.1 a 500 (nebo alternativně 

využít přednastavených hodnot pomocí posuvníku FG Precision Preset – postačí volba 
Low či Medium, která předurčuje hodnoty Initial FG Point Density a Rays per FG Point)

4. Zapnout Global Illumination stisknutím pole Enable a nastavením Maximum Num. Pho-
tons per Sample na hodnotu 1000. 

04-
interier-
mr.max

Obrázek 2.14 Mental ray a výsledek 

aplikování GI na interiér. Renderovací 

čas pod 1 minutu v rozlišení 720×486
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Ve verzi 3ds Max 2009 je nastavení GI pomocí mental ray skutečně jednoduché. Ve srovnání 
s radiozitou vidíte, že nejen doba renderování je podstatně kratší, ale nastavení je mnohem jed-
nodušší. Nyní si vysvětlíme použité parametry.

Initial FG Point Density: Jde o hustotu sítě FG bodů pokrývající celou scénu, které před-
určují, kolik detailů bude mental ray renderovat. Čím větší hustota, tím více detailů. 
Obvykle stačí 0.1–0.8.
Rays per FG Point: Každý FG bod vysílá určitý počet světelných paprsků do scény, jejichž 
hodnotu nastavujete tímto parametrem. Čím vyšší je hodnota, tím detailnější a jemnější 
je osvětlení (bez viditelných fl eků).
Maximum Num. Photons per Sample: Určuje, kolik se využije fotonů pro výpočet inten-
zity GI. Čím vyšší je hodnota, tím méně kontrastních míst (fl eků).

 Více paprsků (Rays per FG Point) přidejte do scény, která má jen malý otvor pro proudění 
světla.
Méně paprsků stačí pro scény s rovnoměrným („plochým“) osvětlením.
Průměrné scéně postačuje 100–500 paprsků.
 Detailním scénám, které obsahují více světelných kontrastů, přidejte více paprsků (1000 a více).
 Pokud scéna obsahuje stále tmavá místa (například rohy místnosti), zvyšte počet odrazů 
světelných paprsků parametrem Diffuse Bounces (1–5).
 Jestliže je scéna příliš tmavá anebo příliš světlá, využijte nastavení logaritmické expozice 
(Rendering → Exposure Control → Brightness).

Obrázek 2.15 Nastavení mental ray na záložce Indirect 

Illumination pro využití GI

Globální osvětlení s mental ray
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Novinkou poslední verze je také možnost generovat FG mapu pomocí tlačítka Generate Final 
Gather Map Now na panelu Indirect Illumination dialogu Render Setup, jak ukazuje obrázek 
2.15. Uložením mapy na disk (Read/Write File) a stiskem tlačítka Generate Final Gather Map 
Now se začne počítat mapa fi nal gather pro všechny animované snímky, aniž byste museli scé-
nu renderovat. Pro omezení nežádoucího efektu poblikávání snímků při síťovém renderování 
použijte tuto funkci pro vygenerování FG mapy u všech snímků a až poté před vlastním rende-
rováním zapněte Read Only (FG Freeze).

Zvýšení energie denního osvětlení a výraznější 
prosvětlení místnosti 

Pokud se vám zdá místnost příliš tmavá, přidejte dennímu světlu více energie. To provedete 
takto: 

Na panelu Modify nastavte u systému Daylight v roletovém menu mr Sun Basic Parameters 
parametr Multiplier na hodnotu 2.0, jak vidíte na obrázku 2.16.

Obrázek 2.16 U systému Daylight jsou v modifi kačním panelu zdvojnásobeny hodnoty 

parametru Multiplier

Fotony jsou světelné částice, které putují scénou, odrážejí se, absorbují se do povrchů, než se 
zcela vstřebají a dále se neodrážejí. Pomocí fotonů a fotonových map napodobuje mental ray 
globální (nepřímé) osvětlení. Které světlo a který objekt přispívá či nepřispívá ke globálnímu 
osvětlení, nastavujete v dialogu Object Properties (vlastnosti objektů) na záložce mental ray 
(klepněte pravým tlačítkem myši na objekt či světlo → Object Properties → záložka mental ray 
→ Generate GI a Receive GI). 

Multiplier=2Multiplier=2

Multiplier=1Multiplier=1

2009

K1623.indd   66K1623.indd   66 31.10.2008   13:42:3831.10.2008   13:42:38



67

G
lo

bá
ln

í o
sv

ět
le

ní
, 

re
nd

er
ov

án
í 

a 
ka

m
er

ov
é 

ef
ek

ty

2

Vylepšení kvality obrazu a odstranění skvrnitých míst 
Následující parametry ovlivní kvalitu výsledného obrazu: 

1. Initial FG Point Density: 1 
2. Rays per FG Point: 1 000 
3. Interpolate Over Num. FG Point: zvyšujte pouze v případě, že scéna obsahuje skvrnitá 

místa. Tímto parametrem docílíte zprůměrování barvy pixelů (zahlazení fl eků), čili jde 
o analogii fi ltru u radiozity

4. Zostření renderovaného obrázku

Ještě před samotným výpočtem emise fotonů a fáze Final Gather je vhodné nastavit, aby Max 
uložil fotonovou mapu pro GI (Photon Map) a výslednou mapu z fáze FG. To lze provést tak, že 
klepnete na tlačítko Browse v části Final Gather Map, nastavíte cestu k uložení mapy, pak akti-
vujete volbu Read/Write pro čtení a zápis do této mapy. Renderování je pak o poznání rychlejší, 
jelikož se načítají vypočtené hodnoty přímo ze souboru na disku.

Pro výraznější zostření obrazu s mental ray (stejně jako při použití ostrých antialiasingových fi l-
trů v režimu scanline) použijte hlavní menu Rendering → Render Setup → záložka Renderer → 
Samples per Pixel. Zde dosáhnete větší ostrosti obrazu zvýšením minimální i maximální hodno-
ty počtu vzorků na pixel, tj. hodnot v polích Minimum a Maximum (z původních hodnot Mini-
mum=1/4, Maximum=4 například na Minimum=4 a Maximum=16). Takto zvýšíte ostrost hran 
modelů v konečném renderu, tedy celkovou ostrost obrazu, stejně jako v režimu scanline pomo-
cí AA fi ltru Catmull-Rom. Pokud hodnoty zvýšíte příliš, čas renderování se výrazně prodlouží! 
Výsledek tohoto nastavení vidíte na obrázku 2.17. Vynikajících výsledků dosáhneme ve srovnání 
s radiozitou nebo light tracer za mnohem kratší dobu a s širšími možnostmi nastavení.

Obrázek 2.17 GI dosažené 

pomocí mental ray. Přesvědčivé 

řešení s krátkou dobou 

renderování

Vylepšení kvality obrazu a odstranění skvrnitých míst 
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AA filtr představuje tzv. antialiasingový filtr, který má na starost vyhlazení schodovitých 
přechodů mezi pixely. Odstraní se tak výraznější zubatost. Catmull-Rom je nejostřejší filtr 
s efektem zvýraznění hran objektů, vhodný pro statické vizualizace ve vysokém rozlišení. 
Na většinu obrázků v této knize je použit právě filtr Catmull-Rom. Všechny AA filtry najdete 
v menu Rendering → Render Setup → záložka Renderer → sekce Antialiasing → pole Filter, 
jste-li v režimu Scanline. 

Pokud si chcete zkontrolovat fi nální nastavení hodnot pro globální osvětlení prostřednictvím 
mental ray, načtěte si ze složky kapitola1-2\max na přiloženém DVD-ROM soubor 01interier-
mr-fi nal.max, pomocí něhož jsme dosáhli vzhledu obrázku 2.17.
Novinkou 3ds Max 2008 bylo uvedení technologie Sky Portal. Jde o efektivní metodu nepří-
mého osvětlení, která nevyžaduje vysoce kvalitní nastavení FG nebo GI. Koncetruje nepřímé 
světlo přesně tam, kam směřuje jeho ikona (například do interiéru, aby nepřímé světlo proudilo 
dovnitř místnosti). Jde o efektivní metodu osvětlení interiéru venkovním světlem. Doba rende-
rování je výrazně kratší, výsledky srovnatelné s metodou fi nal gather a GI. Sky portal najdete 
v menu Create → Lights → Photometric → mr Sky Portal, a aby fungovalo správně, je nutné mít 
ve scéně také světlo Sky (IES Sky, mr Sky nebo Skylight).
Různé odstíny (barevný nádech) světla ve scéně získáte změnou parametru Haze (hodnoty 0 až 
15), který najdete v modifi kačním panelu u systému Daylight na roletce mr Sky: Haze Driven (mr 
Sky). Jeho změnou ovlivňujete barvu a intenzitu nebes, horizontu i slunečního světla a konečně 
také ostrost stínů (Haze=0) či rozptýlenost stínů (Haze=15). 

Haze=0: defi nuje jasnou oblohu
Haze=15: defi nuje zataženo

Možnost výběru mezi dvěma modely nebes (Haze nebo Perez All-Weather v roletovém menu mr 
Sky Parameters světla Daylight) je novinkou 3ds Max 2009. Model Perez All-Weather je považován 
za průmyslový standard a využívejte jej pro denní světlo (není určen pro přítmí či noční scény).
Se světlem Sky Portal a modelem nebes můžete experimentovat ve scéně 04-interier-mr-skypor-
tal.max.

Některá elementární řešení spojená se světly, 
kamerami a renderováním
Volumetrická světla

Pokud chcete vytvořit volumetrické světlo (například kužely nočního osvětlení), máte několik 
možností. Buď s vybraným standardním světlem (v režimu scanline) v modifi kačním panelu 
→ roletové menu Atmospheres & Eff ects → přidat Volume Light, jak ukazuje obrázek 2.18. Pak 
klepnutím na tlačítko Setup vyvoláte přímo dialog Environment & Eff ects, kde volumetrické 
světlo nastavíte detailněji.
Zajímavější, pro mírně a středně pokročilé uživatele určitě lákavější způsob vytvoření 
volumetrického světla je prostřednictvím mental ray a shaderů. Samozřejmě i předchozí postup 
aplikování volumetrického světla bude fungovat v mental ray, ale právě s mental ray je možné 
v roletovém menu Camera Eff ects v rámci dialogu Render Setup přidat kamerové komponentě 
tzv. fyzikální Volume shader s názvem Parti Volume (physics), jak ukazuje obrázek 2.19. Tento 

01interier-
mr-final.

max

2008

2009
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shader vystihuje fakt, že kamera bude v daném objemu světelného kuželu (nejlépe světla typu 
Spot, avšak efekt funguje i s dalšími typy světel) zabírat světelné částice, které fyzický objem 
světla vlastně vytvářejí a vyplňují. Jde o základní shader pro tento efekt. Pokud přetáhnete 
slot s tímto shaderem do prázdného slotu v editoru materiálů jako instanci, budete moci dále 
upravovat jeho parametry. 

Obrázek 2.18 Přidání volumetrického světla k aktuálně vybranému 

světlu v modifi kačním panelu

Prozatím budeme slovo shader chápat zjednodušeně jako nějaký efekt dosažený prostřednictvím 
aplikování určitých funkcí mental ray – více se dozvíte v kapitole o materiálech. 

V editoru materiálů máte u shaderu Parti Volume (physics) 
dva základní parametry, které určují výsledný efekt: Scatter 
Color (barva volumetrického světla) a Extinction (vymizení 
efektu – čím vyšší hodnota, tím nižší viditelný efekt 
volumetrického světla).

Nastavení barvy světla samotného a jeho intenzity 
v modifikačním panelu nemá na výsledný vzhled vliv. 
U samotného světla je dobré v modifikačním panelu 
nastavit Attenuation (úbytek intenzity světla s rostoucí 
vzdáleností od zdroje) na Inverse. Výsledek vidíte na 
obrázku 2.20. 

Obrázek 2.19 Přidání 

shaderu pro volumetrické 

světlo přímo kamerové 

komponentě Volume v rámci 

dialogu Render Setup → 

záložka Renderer

Volumetrická světla

K1623.indd   69K1623.indd   69 31.10.2008   13:42:3931.10.2008   13:42:39



70 Kapitola 2 – Globální osvětlení (GI), renderování a kamerové efekty

Obrázek 2.20 Ukázka volumetrického světla pomocí

 mental ray a Parti Volume (physics) shaderu aplikovaného 

do kamerové komponenty Volume

Ukládání renderovacího nastavení a jeho rychlá změna 
Testování různých scén a přecházení mezi jednotlivými renderery mohou značně urychlit tzv. Render 
Presets (přednastavené hodnoty spojené s renderováním). To znamená, že si můžete uložit například šab-
lonu s těmito hodnotami: mental ray jako aktivní renderer, GI zapnuto, Caustics zapnuty, Final Gather za-
pnuto, kamerový efekt Lens Eff ects v dialogu Environment & Eff ects aktivní, rozlišení 640×480 a podobně. 
Stručně řečeno všechny parametry, které jsou obsahem oblastí na obrázku 2.21 vlevo, lze ukládat v rámci 
Render Presets. Veškerá nastavení pro uložení i načtení nastavení najdete v řádku Preset vespod v dialogu 
Render Setup (F10), jak vidíte na obrázku 2.21. Další možností, jak zpřístupnit tyto volby, je aktivovat zá-
stupné ikony pro rychlý výběr renderovacích nastavení klepnutím pravého tlačítka myši na panelu nástro-
jů a výběrem Render Shortcuts ze seznamu dostupných komponent hlavní nástrojové lišty.

Obrázek 2.21 Možnost uložení a načtení vlastních šablon renderování

Pomocí příkazů Save 
a Load Preset můžete 
ukládat a načítat 
renderovací nastavení
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Vytvoření efektu hvězdné oblohy 
Jestliže ve vašich animacích pracujete s hvězdnou oblohou, můžete využít vestavěného fi ltru obra-
zové události Starfi eld v modulu Video Post (hlavní menu Rendering → Video Post). Jediným pravi-
dlem je, že musíte mít ve scéně vytvořenou kameru, skrze niž budete hvězdnou oblohu zabírat. 
Ve Video Postu přiřadíte vstupní událost scény (Add Scene Event = Camera01) a poté za tuto 
událost obrazový fi ltr Starfi eld, jak naznačuje obrázek 2.22. Obrázek pak vyrenderujete stisknu-
tím tlačítka Execute Sequence.

Obrázek 2.22 Nastavení hvězdné oblohy ve Video Postu

Nastavení hvězdné oblohy (s pohledem z tmavé scény interiéru z předchozí kapitoly o globálním 
osvětlení) najdete v souboru 01-starfi eld.max v adresáři kapitola1-2\max. 

Renderování pro určitý tiskový výstup 
Pokud chcete odevzdat vizualizaci v určitém formá-
tu (např. A3 = 420×297 mm), využijte k tomu spe-
ciálně přizpůsobený dialog v hlavním menu Ren-
dering → Print Size Assistant, kde si můžete zvolit 
mezi jednotlivými typy tisků (od A0 po A5) včetně 
DPI. Samozřejmostí je možnost uložení alfa kanálu, 
jak vidíte na obrázku 2.23, který znázorňuje dialo-
gové okno Print Size Wizard (Průvodce nastavení 
velikosti tiskového výstupu). 

01-
starfield.

max

Obrázek 2.23 Nastavení velikosti 

tisku v dialogu Print Size Wizard

Renderování pro určitý tiskový výstup
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Nastavení kvality a ostrosti stínů 
Pokud ve scéně vytvoříte světlo a máte v modifi kačním panelu zapnuté vrhání stínů, je možné 
nastavit kvalitu a ostrost stínů. To můžete provést v podstatě u všech typů stínů kromě Raytrace, 
které generují pouze ostré stíny. U stínů Shadow Map nastavujete kvalitu a ostrost podle následu-
jícího pravidla:
Vytvořte světlo, například Omni (Create → Lights → Standard Lights → Omni), vyberte jej 
a přejděte do modifi kačního panelu. 

1. Kvalitu mapy stínu (rozlišení) zvyšujete pomocí parametru Map Size v roletovém menu 
Shadow Map Params v modifi kačním panelu. Hodnotu zvyšujte uvážlivě s ohledem na 
počet objektů ve scéně (hodnota 2 048 by měla být dostačující).

2. Ostrost stínů nastavujete pomocí parametru Sample Range. Čím vyšší je tato hodnota, 
tím méně jsou stíny ostré. Naopak, čím nižší je tato hodnota (v kombinaci s vyšší hodno-
tou Map Size), tím jsou stíny ostřejší a blíží se stínům Raytrace.

Dosažení kamerového efektu hloubky zorného pole (DOF) 
Široké zorné pole (vysoká hodnota f-Stop – viz dále) určuje, 
že většina objektů scény je zobrazena ostře. S úzkým zorným 
polem (nízká hodnota f-Stop) jsou ostré pouze ty objekty, 
které leží v určité vzdálenosti od kamery. Ostatní jsou vidět 
rozmlženě. V tomto bodě se podíváme na nastavení DOF 
pomocí mental ray. Abyste mohli efekt spatřit, zapněte 
v dialogu Render Setup → panel Renderer → roletové menu 
Rendering Algorithms pole Enable v části Ray Tracing. Dále 
použijte kamery s cílem (Target Cameras), u nichž nastavte 
Depth Of Field (mental ray) jako Multi-Pass Eff ect, který vidí-
te na obrázku 2.24. 
Cíl kamery se používá pro defi nici vzdálenosti od kamery, ve 
které je objekt vidět ostře (ohnisková vzdálenost), a parame-
tr f-Stop určuje míru rozostření (analogie velikosti apertury 
kamerové čočky – čím větší je apertura, tím nižší musí být 
f-Stop a tím více jsou objekty rozostřené). 

DOF v rámci dialogu Render Setup → panel Renderer → roletové menu Camera Effects je pouze 
pro případy, kdy nemáte ve scéně kameru a používáte pouze perspektivní pohled (zde je Focus 
Plane analogií parametru Target Distance u kamer). Pokud můžete, používejte kamery, jejichž 
možnosti pro nastavení jsou mnohem větší než u perspektivního pohledu, a navíc tak dosahu-
jete realistických výsledků. Výhodou použití Depth of Field (mental ray) je také fakt, že výsledek 
vidíte hned při prvním renderovacím průchodu, kdežto v režimu scanline je konečný výsledek 
vidět až po definovaném počtu průchodů renderu (render Pass), jenž je standardně nastaven 
na hodnotu 12. 

Obrázek 2.24 Aktivní je 

hloubka zorného pole 

pro mental ray
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Obrázek 2.25 Aplikování hloubky zorného pole s cílem kamery zarovnaným na nejbližší konvici

Nastavení DOF najdete v souboru 05-DOF.max v adresáři kapitola1-2\max na přiloženém 
DVD-ROM. Pro experimentování s efektem DOF měňte hlavně polohu cíle kamery a hodnotu 
parametru f-Stop.
Kromě DOF v režimu Scanline a mental ray je v 3ds Max k dispozici ještě renderovací efekt 
Depth of Field, který najdete v menu Rendering → Eff ects → tlačítko Add → Depth of Field. 
Tento efekt představuje třetí možnost dosažení hloubky zorného pole (ostrosti), avšak bez 
použití kamery. Klepnutím na tlačítko Pick Node a výběrem libovolného objektu ve scéně jej 
nastavíte jako ohniskový uzel. Samozřejmě můžete využít i kameru (Pick Cam). Tato alternativa 
s využitím efektu renderování je zřejmě nejrychlejším způsobem výpočtu hloubky zorného pole 
a v produkčním prostředí se z důvodu rychlého výpočtu využívá poměrně často (i přes možné 
nevyužití kamer, jelikož výsledek je nakonec přesvědčivý). 

Pokud pracujete v síťovém prostředí, můžete pro urychlení renderování využít volbu tzv. 
Satellite Systems v rámci distribuovaného renderování, tj. možnosti použít až osm pomocných 
„slave“ procesorů na každou licenci 3ds Max. Nastavení a přidávání hostitelských procesorů 
provádíte v menu Rendering → Render Setup → panel Processing → roletové menu Distributed 
Bucket Rendering. Více informací o této možnosti najdete v nápovědě po zadání klíčového slova 
Satellite Systems. 

Efektnější odlesky – nastavení počtu odrazů 
a lomů světla (trace depth) 

Pokud často pracujete s refl exními materiály, které zabíráte kamerou zblízka, můžete blíže speci-
fi kovat počet odrazů světelných paprsků od objektů navzájem a tím zvýšit vizuální komplexnost 
objektů nebo naopak počet odrazů snížit a urychlit tak renderování. To provádíte s aktivním 
mental ray v dialogu Render Setup → rpanel Renderer → roletové menu Rendering Algorithms 
v části Refl ections / Refractions. Najdete zde tři parametry: 

Max.Trace Depth = udává počet (limit), který nesmí být překročen, pokud sečteme odrazy 
paprsků Refl ection+Refraction (tedy Refl ection+Refraction =< Max.Depth). Stejně tak nesmí 
být tato hodnota překročena jednou z hodnot Max.Refl ections nebo Max.Refractions.
Max.Refl ections = maximální počet odražených paprsků
Max.Refractions = maximální počet lomených paprsků

Efektnější odlesky – nastavení počtu odrazů a lomů světla (trace depth)
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Zapnuté možnosti Enable Refl ections a Enable Refractions pak dovolují renderovat odlesky a lom 
světla při průchodu průhledným materiálem.
Po vyrenderování dvou obrazů s různými hodnotami Max.Refl ections si rozdíly prohlédněte 
nejlépe pomocí nástroje RAM Player (menu Rendering → RAM Player), jak vidíte na dalším 
obrázku.

Obrázek 2.26 Porovnání dvou obrázků s různou hodnotou Max.Refl ections v nástroji RAM Player. 

V prvním případě je nastaven počet Refl ections na 4, ve druhém případě pouze na hodnotu 1.

Testovací scénu z předchozího obrázku najdete v souboru 05-tracedepth.max v adresáři kapito-
la1-2\max na přiloženém DVD-ROM. Zde máte hodnotu Max.Refl ections nastavenu na 2. Zkus-
te scénu vyrenderovat, poté zvýšit tuto hodnotu a znovu vyrenderovat. Porovnejte oba výsled-
ky. Pokud pracujete v režimu scanline, najdete obdobné parametry v dialogu Render Setup → 
záložka Raytracer. 

Prezentace vytvořeného 3D prostoru bez 3ds Max 
Dobrým pomocníkem při prezentacích (zejména architektonických objektů a vizualizací) je 
nástroj Panorama Exporter, který najdete v hlavním menu Rendering. Pokud máte vytvořený 3D 
prostor, pak pomocí panoramatického renderování šesti ortografi ckých pohledů můžete vytvo-
řit samostatný soubor Quicktime *.mov, který lze prohlížet na počítači bez 3ds Max s nainstalo-
vaným přehrávačem Quicktime. Postup je tento: 
Načtěte scénu s kamerovým pohledem, klepněte na menu Rendering → Panorama Exporter, 
pak v modifi kačním panelu klepněte na tlačítko Render…, nastavte rozlišení, velikost apertury 
kamerové čočky (Aperture Width) a nechte si scénu vyrenderovat. Až se vyrenderuje šest pohle-
dů a objeví se prohlížeč s panoramatickým pohledem scény, můžete si výsledek exportovat do 
souboru QuickTimeVR → *.mov.

Další možností prohlížení modelů v 3D prohlížeči nezávislém na 3ds Max je využití aplikace 
Autodesk Design Review, která je zdarma ke stažení na stránkách společnosti Autodesk. Do 
formátu DWF můžete svou scénu exportovat přes menu File → Export → Publish to DWF. 

Ukázku panoramatického pohledu najdete v souboru panorama.mov v adresáři kapitola1-2\obr 
na přiloženém DVD-ROM. Abyste si soubor mohli prohlédnout, musíte mít nainstalovaný pře-
hrávač Quicktime. 

panorama.
mov
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Vytváření kamerových efektů 
Kamerové efekty, to je obecně široký pojem. Mezi základní efekty, které lze dosáhnout v režimu 
scanline, patří zejména Lens Eff ects (Glow, Ring…). Tyto efekty vznikají interakcí světla a objek-
tivu kamery. Přestože se jimi zde nebudeme zabývat detailně, shrneme si základní postup jejich 
aplikování: 

1. Vytvořte ve scéně libovolný typ světla a kameru.
2. V dialogu Rendering → Eff ects přidejte tlačítkem Add Lens Eff ects. 
3. V roletovém menu Lens Eff ects Parameters přidejte z levé části doprava ty elementy, které 

chcete v renderu vidět (Glow, Ring…).
4. Stále v dialogu Eff ects klepněte dole na tlačítko Pick Light a vyberte ve výřezu světlo, 

které má efekt generovat.

I když se v referenční příručce dočtete, že některé tyto efekty (Ring, Glow…) nejsou podporová-
ny v režimu mental ray, budou fungovat. 

My se podíváme na efekty, kterých lze dosáhnout pomocí kamerových shaderů v režimu mental 
ray. Všechny tyto efekty přidáváte prostřednictvím dialogu Render Setup → záložka Renderer 
→ Camera Eff ects. Zde máte tři sloty: Lens (pro efekty kamerové čočky), Output a Volume (pro 
efekty vyplňující objem scény), jak ukazuje obrázek 2.27.
Pokud si vyberete určitý shader, přetáhněte tento slot do editoru materiálů jako instanci, kde 
můžete ovládat další parametry. 
Ve slotu Lens si můžete vybrat: 

Distortion (napodobení zkřivení či prohýbání obrazu, což plyne z reálného jevu nedoko-
nalosti kamerových čoček). Parametry v editoru materiálů jsou Pin Cushion (prohnutí 
obrazu směrem dovnitř) nebo Barrel (prohnutí obrazu směrem ven, což bude mít za 
následek „sudovité“ vidění scény).
Mr Physical Sky nabízí možnost přiřadit do kamerové čočky shader fyzikální model nebes.
Night (lume) shader (akcentuje nevýrazné barvy objektů, které jsou typické v málo 
osvětlených scénách, stejně jako v noci – tento shader napodobuje efekt podle vnímání 
lidským okem, nikoli prostřednictvím kamery). Parametrem Multiplier defi nujete, jak 
bude obraz světlý (vyšší hodnota) nebo tmavší (nižší hodnota). Scéna musí mít samozřej-
mě i bez tohoto shaderu „noční“ nastavení. Shader tento efekt pouze multiplikuje a sám 
jej nevytvoří.
Render Subset of Scene/Masking (mi) shader vám umožní znovu vyrenderovat pouze tu 
část scény či konkrétní objekty, jejichž materiál chcete opravit. Nemusíte tak renderovat 
kvůli malé změně materiálu jednoho objektu celou scénu. Po přetažení shaderu do edi-
toru materiálů můžete přidat požadované objekty tlačítkem Add. Pro urychlení rendero-
vání můžete vypnout pole Calculate FG on All Objects (Entire Image). Pokud však tento 
objekt nepřijímá na svém povrchu světlo odražené od okolních objektů – v tom případě 
byste museli nechat volbu zapnutou. Takto vytvořené změny („inkrementy“) můžete 
použít v případě kompozice fi nálního obrazu například ve Photoshopu.
Shader List (Lens) umožňuje přidat jako vstupní bod seznam naplnitelný dalšími sha-
dery pro účely jejich kombinace. Výstup shaderu prvního v pořadí je současně vstupem 
pro druhý shader v seznamu a podobně. Můžete tak vytvářet kombinované shadery pro 
kamerové čočky.

Vytváření kamerových efektů
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WrapAround – užitečný shader, který zabírá celou scénu kolem kamery v 360 stupních, 
a výsledný obrázek lze použít jako sférickou refl exní mapu nebo mapu prostředí, kterou 
si můžete uložit i jako HDRI mapu.

V adresáři kapitola1-2\max na přiloženém DVD-ROM si můžete prohlédnout soubory camFX-wrapa-
round.bmp a camFX-distortion.bmp s efekty Distortion a WrapAround. 

Obrázek 2.28 Ukázka kamerového shaderu Mist přiřazeného v komponentě Volume

Obrázek 2.27 V dialogu Render Scene 

nastavujete kamerové efekty prostřednictvím 

mental ray shaderů
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Ve slotu Volume si můžete vybrat:
Mist – Scéna se zaplní mlhou. Základní parametry, které udávají výsledný vzhled sním-
ku, jsou Transparency (průhlednost – čím vyšší je hodnota, tím méně mlhy), Solid Color 
(vlastní barva mlhy), Layering (defi nuje vrstvení mlhy u země) a Density (hustota mlhy). 
Ukázku shaderu Mist (lume) vidíte na obrázku 2.28.
Beam, Parti Volume, Material To Shader a Submerge jsou předmětem třetí kapitoly o ma-
teriálech.
Ve slotu Output je nejzajímavější shader Glare, který vytváří záři kolem velmi jasných částí 
ve scéně (například kolem okna uvnitř tmavé místnosti, kudy proudí sluneční světlo).

Úprava tříbodové perspektivy kamery na dvoubodovou 
Když vytváříte kamery, může se stát, že kamerový pohled se deformuje a vertikální hrany objek-
tů, které jsou ve skutečnosti rovnoběžné, se jakoby sbíhají. To je z důvodu, že kamery používají 
standardně tříbodovou perspektivu. Aby se vertikální linie jevily jako skutečně vertikální, bude 
třeba vybrané kameře přiřadit modifi kátor Camera Correction z hlavního menu Modifi ers → 
Cameras. Na dalších obrázcích vidíte ukázku tříbodové perspektivy (příklad 1) a dvoubodové 
s aplikovaným Camera Correction (příklad 2). 

Obrázek 2.29 Kamera bez použití 

modifi kátoru Camera Correction (příklad 1) 

a s využitím kamerové korekce (příklad 2)

Uložení obrázku s alfa kanálem 
Alfa kanál, který s sebou nese informaci o průhledných a neprůhledných částech obrazu, lze 
získat přímo v 3ds Max, aniž byste museli přecházet například do Photoshopu pro vytvoření 
černobílé bitmapy jako zdroje pro opacitní mapu. Uvedeme si typický postup. Řekněme, že jste 
na Internetu našli pěkné modely aut nebo stromů a chtěli byste je použít ve vaší vizualizaci ve 
větším množství. Problémem je jejich hustá síťovina a nároky na RAM paměť, popřípadě práce 
přímo ve výřezu a renderování jsou pomalé. Vytvořte si tedy obrázky pohledů jednotlivých 
modelů (pohledy musí odpovídat fi nální poloze aut ve vizualizaci) a uložte je jako soubor TGA 

Uložení obrázku s alfa kanálem

1.

2.
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nebo TIFF. Tyto typy souborů s sebou ukládají informaci o alfa kanálu, tedy o tom, která místa 
obrázku představují skutečnou geometrii scény a která místa naopak žádné pixely neobsahují 
(nezasahuje tam žádný model, místo je „volné“). Tento jediný soubor poslouží jako opacitní 
a difuzní mapa zároveň. V opacitním kanále stačí pouze u bitmapy nastavit Mono Channel Out-
put → Alfa (viz obrázek 2.30). Pokud ten samý TGA nebo TIFF obrázek přidáte u téhož mate-
riálu také do difuzního kanálu (Diff use Map) a tento celý materiál aplikujete na rovinný objekt 
Plane se stejnou velikostí (šířkou a délkou) jako rozlišení TGA (nebo TIFF) obrázku, dosáhnete 
stejného vzhledu s mnohem nižšími nároky na RAM paměť. 

Takto můžete vytvářet průhledné objekty (například oplocení, sítě a podobně) na základě vámi 
vytvořené masky – černobílého obrázku – kterou vložíte do mapového kanálu Opacity v roletce 
Maps editoru materiálů. Výstup tohoto pracovního postupu poslouží také pro kompozici obra-
zových vrstev ve 2D aplikaci, jakou je například Adobe Photoshop.

Konverze standardního světla na plošné světlo 
Pokud pracujete s mental ray, měli byste využívat standardní světla mr area omni nebo mr area spot. Tato 
světla jsou napsána speciálně pro mental ray a také mají větší možnosti nastavení než ostatní standardní 
světla. Než se dostaneme k samotné konverzi standardních světel na plošná, defi nujme obě světla: 

mr Area Omni = světlo, které napodobuje 3D světelný zdroj (v modifi kačním panelu 
můžete v roletce Area Light Parameters vybrat emitery (objekty, které světlo vysílají) 
Sphere nebo Cylinder) 
mr Area Spot = světlo, které napodobuje 2D světelný zdroj (v modifi kačním panelu 
můžete v roletce Area Light Parameters vybrat volbu Rectangle nebo Disk)

Máte-li ve scéně standardní světla (spotlight nebo omni světla) a uvažujete o renderování v men-
tal ray s adekvátními světly (fyzikálně založenými), můžete všechna tato světlo naráz zkonver-
tovat na světla mental ray. To provedete takto:

Obrázek 2.30 Alfa kanál v opacitní složce materiálu 

Standard, který se ukládá automaticky se souborem TGA
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1. Vyberte všechna světla, která se mají zkonvertovat na plošná mr světla. 
2. Přejděte do panelu Utilities a klepněte na tlačítko MAXScript. Dole vyberte z roletového menu 

skript Convert to mr Area Lights. Objeví se tlačítko Convert Selected Lights. Klepněte na něj. 
3. Objeví se dialog, který se vás zeptá, zda chcete smazat původní světla. To není třeba 

(můžete se k nim později vrátit). Klepněte tedy na No. Nyní se ve scéně aktivovala na 
místech původních světel nová plošná světla mental ray a jsou rozsvícená. Původní svět-
la jsou na těch samých místech, ale jsou vypnutá. Nyní máte ve scéně oba typy světel 
– původní standardní i mental ray plošná světla.

Změna vzhledu stínů plošných světel 
Když máte ve scéně plošná světla, u nichž jsou aktivní stíny Raytrace, můžete i tak ovládat vzhled 
stínů včetně defi nování ostrosti hran (na rozdíl od standardních světel a raytrace stínů). Na obráz-
ku 2.31 vidíte modifi kační panel fotometrického světla Free Light. Typ světla je nastaven na sféric-
ký tvar (Sphere). Parametr Light Shape Visible in Rendering zajistí, že světlo uvidíte i v renderu.

Obrázek 2.31 Parametry obdélníkového tvaru světla 

(1) a modifi kační panel 3D světla typu Free Light 

s možností defi nování velikosti zdrojového světla (2). 

Záři kolem světel dosáhnete kamerovým shaderem 

Glare.

Obrázek 2.32 Světlo mr Area Spot se 

stíny Raytrace – dimenze světla v prvním 

případě jsou délka=1 a šířka=1, hodnota 

U/V Samples =5/5; dimenze světla 

v druhém případě jsou délka=70 a šířka 

=70, hodnota U/V Samples=10/10

Změna vzhledu stínů plošných světel

1 2
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Velikost plošného obdélníkového světla typu Rectangle (vybíráte ze stejného seznamu jako sfé-
rický typ), a tudíž i vzhled a ostrost okrajů stínů defi nujete pomocí parametrů Height (výška) 
a Width (šířka). Konečně pomocí vzorků U/V Samples defi nujete kvalitu stínů. Zvětšíte-li světlo, 
stíny budou rozptýlenější (difuznější) s rostoucí vzdáleností od objektu, který je vrhá. Jestliže 
bude v oblasti stínů příliš šumu, zvětšete počet vzorků, čímž stíny dosáhnou větší integrity bez 
zrnitosti. Porovnání výsledků renderu téhož světla s různou velikostí vidíte na obrázku 2.32. 
Hodnoty parametrů jsou samozřejmě závislé na poloze a orientaci světla. 

Pro urychlení testovacích renderů s plošnými světly, pokud zrovna nesledujete kvalitu stínů, 
zapněte parametr Area Lights/Shadows as Points v dialogu Render Setup → záložka Common 
→ část Options. Tím se budou světla renderovat jako bodová a nikoli plošná. To zkrátí dobu 
renderování, neboť plošná světla jsou výpočetně náročnější než bodová světla. 

Testovací soubor s plošným světlem z obrázku 2.32 najdete v souboru kapitola1-2\max\08mrarealights.
max a se sférickým světlem v souboru 02_Glare_AreaLight.max na přiloženém DVD-ROM. 

Správná kombinace obrázku na pozadí s 3D objektem 
Pokud pracujete často se zasazením 3D geometrie do reálné fotografi e, bude třeba zamyslet se 
nad dvěma okolnostmi: 

Jak docílit efektu, aby 3D model tematicky zapadl do prostředí na fotografi i (tj. aby vrhal 
stíny na části fotografi e a aby světlo na 3D modelu odpovídalo světlu na fotografi i)? 
Jak zarovnat kameru v 3ds Max s pohledem fotoaparátu, který fotografi i vytvořil? 

Nejprve se podíváme na první problém. Řešení spočívá v použití materiálu Matte/Shadow, který 
aplikujete na objekt pokrývající tu část obrázku, na kterou má dopadat stín 3D modelu. Princip 
si ukážeme prakticky. 
Na obrázku 2.33 vidíte v příkladu 1 nastavení scény ve výřezu. Model konvice uvnitř trouby je uza-
vřen mezi třemi rovinami (z toho první dvě jsou spojené v jeden objekt a zadní rovina je samostat-
ná), na které je aplikovaný materiál Matte/Shadow. Tyto rovinné objekty nebudou ve výsledném 
renderu vidět, avšak budou na nich vidět stíny od konvice (stíny od všesměrového světla). 

Obrázek 2.33 Nastavení scény pro použití materiálu Matte/Shadow (příklad 1) a výsledný 

obrázek s vrženými stíny (příklad 2)

02_Glare_
AreaLight.

max

1 2
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Pokud renderujete s mental ray, použijte pro tyto účely nový materiál Matte/Shadow/Refl ecti-
on (mi). Zde parametru Camera Mapped Background přiřaďte shader Environment/Background 
Camera Map s aplikovanou planární bitmapou prostředí (fotografi í). Celý tento materiál pak 
aplikujte na podlahu nebo obecně objekt, který má přijímat vržené stíny.
A jak se nastaví správné osvětlení s fotografi í na pozadí? K tomu využijte novou možnost 3ds 
Max 2009 – shader Environment/Background Switcher. Tento shader aplikujete do mapy pro-
středí (Rendering → Environment → Environment Map). Pak jej přetáhněte jako instanci do 
editoru materiálů. Pro to, abyste správně nastavili mapy prostředí pro přesvědčivé osvětlení, 
budete potřebovat dva dílčí shadery, kterými naplníte Environment/Background Switcher:

Background: Mapu pozadí (aplikovaná v rámci Background Camera Map shader) – kla-
sická fotografi e pozadí scény.
Environment/Refl ections: Sférickou mapu tohoto prostředí, která poslouží jako refl exní 
mapa pro odrazy (pokud máte pouze fotografi i či obrázek chromované koule, na níž se 
odráží toto okolí, aplikujte ji sem jako Environment Probe/Chrome Ball shader). Jestliže 
máte skutečnou sférickou HDR mapu okolí (získanou například přes kamerový efekt 
Wrap Around – náš případ), aplikujte ji sem jako klasickou mapu Bitmap se sférickým 
mapováním. 

Na obrázku 2.34 vidíte kompletní nastavení v rámci shaderu Environment/Background Switcher. 
V souboru 12-enviroshader.max najdete toto nastavení s naší scénou interiéru. Prozkoumejte 
detailně nastavení scény včetně 2 světel – fotometrického světla Target Light a Skylight s volbou 
Use Scene Environment (čili s využitím mapy prostředí pro účely osvětlení). 

Tento princip lze tedy využít pro kombinace reálných fotografi í a 3D modelů z pohledu světla 
a stínů. 
Druhým problémem je zarovnání kamery Maxe s pohledem a pozicí fotoaparátu, který vytvořil 
fotografi i na pozadí ve výřezu. Toho docílíte buď prostým odhadem nejlépe se zapnutou mož-

Správná kombinace obrázku na pozadí s 3D objektem

Obrázek 2.34 Nastavení map prostředí 

Mapa pro Env/Back Cam Map shader

Mapa pro Env Probe/Chrome Ball shader 
nebo jednoduchá mapa Bitmap se 
sférickým mapováním (HDRI – náš případ)

2009

2009
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ností Show Horizon u kamery, pokud jsou vaše fotografi e z prostředí, kde vidíte horizont. Lze 
tak zarovnat horizont kamery s horizontem na fotografi i. 
Druhou a přesnější možností je tento postup: 

1. S fotografi í na pozadí si na ní vyberte minimálně pět referenčních bodů, u nichž znáte 
dimenze (například některé rohy budovy, pro niž znáte délku, výšku i šířku). Referenční 
body nesmí ležet v jedné rovině. Pokud body na fotografi i vystihují místa, která jsou růz-
norodá co do umístění (různá výška, hloubka ve scéně a podobně), bude odhad pozice 
kamery lepší.

2. Vytvořte si ve správných měrných jednotkách základní 3D model(y) podle vytipované-
ho objektu na obrázku (například budovu v podobě boxu s dimenzemi odpovídajícími 
skutečné budově) – zatím je lhostejné, zda skutečný 3D model zarovnáte s předmětem na 
obrázku či nikoli. 

3. Se zapnutým 3D přichytáváním vytvořte ve vybraných vrcholech modelu(ů) pomocné 
objekty Create → Helpers → Camera Points. To jsou referenční body, které využije utilita 
Camera Match pro odhad pozice kamery Maxe.

4. S vytvořenými CamPoints přejděte do panelu Utilities → Camera Match.
5. Vyberte první Campoint v roletovém menu CamPoint Info, klepněte na tlačítko Assign 

Position a klepněte ve výřezu na to místo na fotografi i, které odpovídá tomuto kamerové-
mu bodu.

6. Postupujte takto se všemi kamerovými body a po vytvoření minimálně pěti pozic na foto-
grafi i klepněte na tlačítko Create Camera. Vytvoří se kamera, která odpovídá pohledu 
kamery z fotografi e. V poli Current Camera Error se objeví hodnota chyby odhadu. Čím 
je tato hodnota nižší (kolem 0 až 1,5), tím lépe. Abyste chybu snížili, upravujte hodnoty 
souřadnic v části Input Screen Coordinates.

Testovací soubor s materiálem Matte/Shadow najdete v souboru kapitola1-2\max\09-matte-sha-
dow.max na přiloženém DVD-ROM.

Efektivní renderování pouze izolovaných částí scény 
Novinkou ve verzi 2009 je tzv. Reveal technologie renderování. Ta umožňuje provádět iterativní 
renderování (čili opakované) na určitých izolovaných oblastech scény nebo vybraných mode-
lech. Pokud provádíte změny pouze na určitých částech scény, je to nejlepší volba, jak si ušetřit 
čas. Nemusíte totiž renderovat celou scénu i tam, kde jste neudělali žádné změny. Iterativní ren-
derování, které najdete v okně Rendered Frame Window (hlavní menu Rendering → Rendered 
Frame Window), vyberete podle obrázku 2.35. Pokud budete renderovat s touto možností, igno-
ruje se síťové renderování, výstup do souboru, renderování vícero snímků naráz nebo export 
do MI souborů (popis scény v jazyce mental ray, pomocí něhož může scénu vyrenderovat).  Jde 
o rychlou volbu, pokud například testujete vhodnost materiálu. Okno Rendered Frame Window 
koncentruje většinu podstatných parametrů, abyste při změnách či aktivování/deaktivování 
funkcí, jako jsou odlesky, stíny, FG nebo subset pixels, nemuseli toto okno opouštět. Ve spojení 
s kamerovým shaderem Render Subset of Scene/Masking (mi) – viz kapitola „Vytváření kame-
rových efektů“ – můžete tohoto principu využít k renderování pouze pozměněných parametrů 
scény (zejména materiálů) a významně zkrátit dobu renderování.

09-matte-
shadow.

max

2009
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Obrázek 2.35 V okně Rendered Frame Window máte přístup k iterativnímu renderování, stejně 

jako z hlavní nástrojové lišty. Toto okno obsahuje přístup k mnoha přínosným funkcím včetně 

nastavení oblastí k renderování (Area To Render → Region).

Renderování mnoha instancí jednoho objektu 
Pokud budete chtít renderovat jeden objekt ve scéně mnohokrát (mnoho stromů, vojáci na bitev-
ním poli, diváci v auditoriu a podobně), máte pro tyto účely možnost použít novinku verze 
2009, mental ray Proxy. Je určen pro velké scény renderované s mental ray. Tato metoda se také 
hodí pro použití s modely s vysokým počtem polygonů. Celkově jde o úsporu paměti a času. Jde 
o zástupné objekty vlastní geometrie, které si drží informaci o referovaném modelu. Zdrojový 
objekt může být animovaný a mít přiřazený materiál. Původní model se pak konvertuje na mr 
Proxy uchovávající informace o modelu zapsané na pevném disku. Zdrojový model pak můžete 
smazat, protože je uložen v mr Proxy. Objekty mr Proxy pak po scéně rozmístíte, jako byste to 
učinili s originálními objekty.
Postup je následující:

1. Vytvořte zdrojový objekt (například jeden strom).
2. Vytvořte mental ray proxy z menu Create → mental ray → mr Proxy.
3. V modifi kačním panelu s vybraným mr Proxy klepněte na tlačítko None a vyberte ve 

výřezu model (strom), který chcete po scéně renderovat. Model změňte (modifi kátory) 
ještě před konverzí na mr Proxy, protože pozdější změny byste museli promítnout apli-
kováním nové konverze objektu na mr Proxy.

4. Klepněte na tlačítko Write Object To File pro zápis informací do souboru na disku.
5. Zadejte název souboru.

Iterativní renderovnání

Renderování mnoha instancí jednoho objektu

2009
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84 Kapitola 2 – Globální osvětlení (GI), renderování a kamerové efekty

6. Nastavte, zda chcete uchovat jeden snímek nebo celou animaci.
7. Zástupné objekty se ve scéně objeví ve formě tzv. point cloud (shluk bodů). Rozmístěte 

kopie mr Proxy libovolně po scéně, aby se objekt renderoval vícekrát.

Obrázek 2.36 mr Proxy umožňuje renderovat mnoho objektů 

s vysokým rozlišením v jedné scéně. Operuje šetrně s pamětí 

počítače a dokáže si poradit i s mnoha animovanými objekty.

Mr Proxy nedědí materiál původního objektu, proto musíte požadovaný materiál přiřadit po 
konverzi znovu.

Vylepšení ve verzi 2009 doznala také část objektových vlastností mental ray pro interakci 
vybraného objektu a světla. Dialog Object Properties na záložce mental ray obsahuje funkce pro 
ovládání final gather a kaustiky společně s GI. Každý objekt tak může například individuálně při-
jímat GI (Receive Global Illumination), ignorovat FG (Pass through – Invisible to FG) nebo vynechat 
objekt z kaustických efektů a další kombinace.

2009
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Další novinkou je nový engine (algoritmus) pro výpočet raytrace akcelerace – BSP2 (Binary 
Space Partitioning). Mental ray používá dva způsoby výpočtu akcelerace: BSP a BSP2. Metoda 
akcelerace BSP2 je poprvé uvedena v 3ds Max 2009 a je určena (optimalizována) zejména pro 
objemné scény (více než milion trojúhelníků) a lépe využívá dostupnou paměť (vyžaduje méně 
RAM). BSP používejte spíše pro menší scény provozované na systému s jedním procesorem. BSP 
a BSP2 vybíráte v dialogu Rendering → Render Setup → panel Renderer → roletka Rendering 
Algorithms → Ray Tracing. 

Nahrazení zástupného 2D objektu 3D modelem
Pokud přejímáte výkresy od architektů pro 3D modelování a následné úpravy scény, můžete 
využít modifi kátoru Substitute. Ten dokáže nahradit vybrané 2D tvary 3D modelem, podobně 
jako na obrázku 2.39. Stačí 2D tvarům hromadně přiřadit modifi kátor Substitute (Modifi ers → 
Parametric Deformers) a tlačítkem Pick Scene Object (vybrat objekt ve scéně) nebo Select Xref 
Object (vybrat externí objekt mimo scénu) klepnout na objekt ve výřezu. 3D objekty nahradí 
2D tvary. Tento princip je aplikovatelný i na 3D objekty (tj. nejen 2D tvary). Zároveň můžete 
modifi kátor využít pro zjednodušení zobrazení objektů ve výřezu. Náhradní zástupný model 
může být zobrazen ve výřezu (jeho jednoduchá nenáročná alternativa), ale renderovat se bude 
detailní model.

Obrázek 2.37 Objektové 

vlastnosti umožňují 

na záložce mental ray 

nastavovat interakce světla 

a vybraného objektu

Obrázek 2.38 Metoda BSP2 

pro výpočet raytrace akcelerace

Nahrazení zástupného 2D objektu 3D modelem

2009
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Obrázek 2.39 Modifi kátor Substitute dokáže nahradit libovolný objekt 

(zástupce) skutečným 3D modelem

Zapečení informací o světle do textury 3D modelu s mental ray
Někdy je potřeba zapéct hodnotu osvětlení přímo do textury modelu, například pro účely her, 
kde není možné renderovat nepřímé osvětlení v reálném čase. Tento proces se nazývá Texture 
Baking. K tomuto postupu se využívá několik nástrojů. Jsou jimi Render To Texture, Ambient 
Occlusion, Unwrap UVW, Vertex Paint a nepřímé osvětlení s mental ray. Efekt Ambient Occlu-
sion vidíte na obrázku 2.40.

Obrázek 2.40 Ambient Occlusion dostupný v rámci materiálu Arch&Design v roletce Special 

Eff ects dokáže zvýraznit detaily při účinku nepřímého osvětlení

Pomocí těchto funkcí budete moci v 3ds Max nechat spočítat reálné globální osvětlení a poté výsle-
dek uložit do textury modelu, aby se příště celý proces nemusel znovu počítat. Postup je následující:
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1. Vytvořte model, do něhož chcete „zapéct“ nepřímé osvětlení.
2. Nastavte osvětlení společně s metodou Final Gather, jak jsme popsali v bodě „Kde zapnout 

globální osvětlení?“. Final Gather nastavte pro účely kvalitního výstupu pro Render To 
Texture na vyšší hodnotu (Medium nebo High).

3. Aplikujte modifi kátor Unwrap UVW, protože nástroj Render To Texture (který násled-
ně použijete) potřebuje správné rozvržení UV souřadnic. Nejdříve vyberte všechny plo-
chy čelní modelu (Faces), klepněte na tlačítko Edit a aplikujte planární mapování přímo 
z dialogového okna Edit UVWs (menu Mapping → Flatten Mapping…), jak ukazuje obrá-
zek 2.41. Pokud by byl model organičtějšího tvaru, museli byste použít jiné mapování.

Obrázek 2.41 Aplikování planárního mapování Flatten Mapping pro rozložení textury 

ve 2D prostoru

4.  Vyberte model a spusťte Render To Texture (Rendering → Render To Texture).
5.  Vypněte kontrolu expozice, protože pro nástroj Render To Texture není doporučena mr 

Photographic Exposure Control.
6.  Nastavte zde parametry podle obrázku 2.42. Nezapomeňte přiřadit na pozadí Element 

Background podobnou barvu, jako je difuzní barva modelu (zkopírujte přes pravé tlačít-
ko myši → Copy z editoru materiálů), aby se výsledný obrázek lépe smíchal s pozadím.

7.  Stiskněte Render z dialogu Render To Texture.
8.  Počkejte na výsledek a přejděte do editoru materiálů. Kapátkem načtěte materiál z objektu 

ve výřezu do prázdného slotu editoru. Objeví se materiál Shell, u něhož Baked Material je 
právě výsledná textura obsahující informace o světle i ambient occlusion, které jsou nyní 
uloženy v podobě obrázku do difuzního kanálu. Abyste si toto ověřili, přetáhněte slot 
Baked Material do nového prázdného slotu editoru a podívejte se do difuzního kanálu, 
kde bude uložen TGA obrázek. Materiál Shell je unázorněný na obrázku 2.43.

9. Texturu uvidíte přímo ve výřezu aplikovanou na objekt (pro zvýraznění nastavte Self-
Illumination na nejvyšší úrovni materiálu na hodnotu 100).

1.

2.

3.

4.

Zapečení informací o světle do textury 3D modelu s mental ray
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10. Aby se informace mohly uložit přímo do vrcholů modelu, bude potřeba zvýšit detaily 
síťoviny. Aplikujte proto Subdivide modifi kátor, nebo ještě lépe přidejte detaily ručně, 
aby se automaticky nepřidaly tam, kde nejsou nutné.

11. O zachycení mapy do vrcholů modelu se postará modifi kátor Vertex Paint. Aplikujte jej 
v zásobníku nad Subdivide. Zde v roletce Assign Vertex Colors vyberte v části Light Model 
přepínač Diff use Only, aktivujte Mapping v části Rendering Options a nakonec stiskně-
te tlačítko Assign. Všechny informace jsou nyní zapečené přímo ve vrcholech modelu. 
Informace zapsané v kanálech vrcholů můžete zkontrolovat utilitou Tools → Channel 
Info. Na obrázku 2.44 vidíte všechna potřebná nastavení modifi kátoru Vertex Paint

Obrázek 2.42 Nastavení 

parametrů Render To Texture 

pro vytvoření textury 

s informacemi o nepřímém 

světle a Ambient Occlusion

Obrázek 2.43 Materiál Shell se vytvoří 

automaticky po dokončení procesu Render 

To Texture a je dostupný v editoru 

materiálů po načtení textury z objektu 

ve výřezu
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Obrázek 2.44 Modifi kátor Vertex Paint zajistí načtení informací ze zapečené textury do vrcholů 

modelu a efekt je viditelný přímo v pracovním prostředí

Nyní můžete renderovat scénu bez jakýchkoli světel a Final Gather, a přesto bude výsledek vypa-
dat podobně, jako kdybyste scénu měli nastavenu s fi nal gather a světly. Tento postup funguje 
samozřejmě také v režimu Scanline.

Renderování jednotlivých komponent obrazu 
ve vrstvách pro použití v externí 2D aplikaci 

Mnohdy je výhodné vyrenderovat jednotlivé komponenty obrazu samostatně, abyste s nimi 
poté mohli pracovat v některé aplikaci pro úpravu barev, stínů, světla, jasu, efektu Ambient 
Occlusion či dalších parametrů obrázku. Tento postup má mnoho výhod – ať možnost úpra-
vy obrazu jednodušším a rychlejším způsobem bez znovuopakování renderování po zjištění 
nějakého nedostatku (např. příliš tmavé stíny) nebo předání vaší práce do postprodukce. 3ds 
Max nabízí mnoho takových komponent, které můžete renderovat samostatně do zvláštních 
souborů (vrstev) a pak je libovolně kombinovat. Obrázek 2.45 ukazuje nabídku elementů ren-
derování (tzv. Render Elements). 

Renderování jednotlivých komponent obrazu ve vrstvách pro použití v externí 2D aplikaci

K1623.indd   89K1623.indd   89 31.10.2008   13:42:5131.10.2008   13:42:51



90 Kapitola 2 – Globální osvětlení (GI), renderování a kamerové efekty

Pojďme se podívat na pracovní postup, v němž využijete Render Elements.  
1.  Nastavte komplexně scénu s materiály, světlem, fi nal gather, Ambient Occlusion či dalšími 

efekty.
2.  Otevřete dialog Render Setup z hlavního menu Rendering.
3.  Zde přejděte na záložku Render Elements, jak ukazuje obrázek 2.46.
4.  Tlačítkem Add přidejte požadované elementy, s nimiž bude pracovat odděleně v některé 

kompoziční aplikaci. Elementů je zde hodně včetně těch speciálně určených pro mental ray 
a materiál Arch&Design. Běžně používanými jsou Diff use, Lighting (nebo adekvátně mr 
AD Raw Diff use Direct a Indirect), Refl ections, mr AD Raw Ambient Occlusion, Alpha, Sha-
dow nebo Masky (Mattes), kde si můžete vybrat individuální objekty, kterým budete chtít 
upravovat některé vlastnosti (např. barva) v kompoziční aplikaci. Každý element zachycuje 
určitý aspekt obrazu. Tak například element Alpha funguje pro celý obraz jako maska, 
která si je vědomá, jaké objekty se ve scéně nacházejí, kde jsou umístěné a jak je oddělit od 

Obrázek 2.45 Render Elements jsou klíčovou technologií 

pro renderování jednotlivých komponent obrazu odděleně 

pro možnosti následné kompozice (např. v Adobe Photoshop)
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Obrázek 2.46 Klíčové vyrenderované elementy použitelné v některém kompozičním programu. 

Jejich skládáním a aplikováním individuálních změn lze dosáhnout zcela odlišných obrazových 

výstupů než při renderování. Vyhnete se tak nutnému opakovanému renderování při odhalení 

chyb zachycených v některém z elementů.

Obrázek 2.47 Nahrazení pozadí obrázku vyrenderovaného v 3ds Max obrázkem pozadí v aplikaci 

Adobe Photoshop

Renderování jednotlivých komponent obrazu ve vrstvách pro použití v externí 2D aplikaci
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pozadí. Abyste mohli měnit pozadí (v našem případě to je mr Physical Sky), můžeme ve 
Photoshopu tuto masku použít a vyměnit pozadí vyrenderované v 3ds Max za jakýkoli jiný 
obrázek). To je smyslem všech elementů a možné použití vidíte na obrázku 2.47.

5.  V aplikacích, jako je Adobe Photoshop nebo Autodesk Combustion, můžete jednoduše 
obrázky přidávat do vrstev, aplikovat na ně fi ltry (Photoshop) nebo operátory (Combusti-
on) a kombinovat s Alfa kanálem pro odkrytí pouze určitých částí scény.

Novinkou verze 3ds Max 2009 je také mr Labeled Element, který umožňuje výstup jedné nebo 
více větví materiálového stromu do podoby elementu. Stačí, pokud na počáteční větvi hierarchie 
materiálu přiřadíte nový shader mr Labeled Element a ponecháte všechny původní mapy (Keep 
old map as sub-map). Pak stačí jen z panelu Render Elements vybrat jako aktivní mr Labeled 
Element. Mr A&D Elements jsou určené pro objekty, které mají přiřazeny materiál Arch & 
Design (tudíž lze použít pouze mental ray, nikoli scanline). Tyto elementy jsou rozděleny do 
tří skupin: Raw, Level a Output. Takto vyrenderované obrazy můžete uložit jako HDR a nechat 
složit v některém kompozičním programu.

Testovací soubor s nastavením renderovacích elementů najdete v souboru kapitola1-2\max\02_
Render_Elements.max na přiloženém DVD-ROM.

02_
Render_

Elements.
max

2009
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